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Introduction

This document is for everyone who designs Microsoft Tag solutions. It
describes practical considerations for successfully creating and deploying
Tag barcodes, QR Codes, and NFC URLs using the Microsoft Tag solution.
It offers instructions and best practices for streamlining production,
verifying usability, and ensuring a superior user experience.
This document is part of a series of guides that supplement information
available on the Microsoft Tag and Microsoft Tag Developer Center
websites. It will be updated and expanded as the Tag solution evolves.
Check the Microsoft Tag website for the latest version of this guide.
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Best Practices

Tag barcodes, QR Codes, and NFC URLs should be produced and
displayed so that users can physically locate and scan them reliably with
their mobile devices. Choose a delivery medium that makes practical
sense for your campaign and the type of recognition technology
you use. Each type has slightly different requirements in terms of
discoverability, usability, and accessibility. This implementation guide
describes requirements and best practices for working with Tag
barcodes, QR Codes, and NFC URLs using the following media types:
• Print—Magazines, posters, flyers, pamphlets, product packaging, and other
printed media.

• Electronic displays—Computer screens, TVs, JumboTrons, and other lightemitting media.

• Apparel and other media—Screen-printed on clothing or composed of other
materials, such as embroidery, a chocolate wafer, on a watch face, or printed on a
bottle, to name a few possibilities.

One of the great things about new marketing tools is the wave of
creative energy they unleash. Think of all the clever places you’ve seen
promotional content from skywriting to advertisements on grocery store
floors. So too with mobile marketing; the natural inclination is to use
recognition technologies such as Tag in a number of unusual locations.
As you plan ways to incorporate recognition technologies in your
campaign, you should map out the likely usage scenarios and consider
the pros and cons of placing your items in different places and
situations. Make sure to ask—and answer—the following questions:
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• What materials will your Tags be made of?
• On what kinds of surfaces will you place your Tags?
• What are the physical conditions or environments in which users will discover your
Tags?

• How will users be expected to interact with the content in your Tags?
These practical recommendations can help guide you in creating and displaying
Tags to successfully communicate the encoded information you want to share
with your audience.

DO’S AND DON’ TS
DO
• Define your target audience and communications goals: Make sure your
experience is timely and useful.

• Offer a clear value: Design your materials to ensure people know what to do and
what they’ll get.

• Think globally: Consider globalization and localization issues in large campaigns,
including social and political appropriateness, user comprehension, and so on.

• Include instructions: Tell people how to interact with your content with clear
user instructions and context for your Tag barcode, QR Code, or NFC touchpoint.

• See how people react: Field-test your campaign experience with a cross-section
of target users. Step through the entire real-world user experience to solve
problems proactively.

• Maintain image proportions and white border. Make sure your Tag barcode or
QR Code image isn’t distorted during the design and print process and that your
design doesn’t impinge on the mandatory white border around your Tag or QR
image.
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• Thoroughly test each type of recognition technology you use:
- In the actual target environment.
- Using a variety of high-end and low-end devices from a variety of manufacturers.
- On devices that run a variety of operating systems.
- On devices that use a variety of web browsers.
- On every type of surface you plan to use. Go through the complete printing or
production process, particularly with unusual materials, such as food or fabric.

D O N OT U S E R E C O G N I T I O N T E C H N O LO G I E S
• In situations that would be unsafe for users to scan the item. Billboards,
for example, are okay for pedestrians and passengers, but a Tag barcode on a
billboard along a busy highway may be a dangerous distraction for drivers.

• In locations that are difficult or impossible for users to be able to scan

reliably. A Tag barcode displayed on the side of a city bus, for example, will be
tough to scan when it’s moving through traffic.

• In locations with poor cell reception. Be mindful of situations where users
may have a poor or no cell signal. Signage in subways, for example, can be
problematic.

• On surfaces that are too reflective, curved, or irregularly shaped. Glass can
be difficult to scan In locations where the relative position of the user may be too
close, too far, or at too acute of an angle to scan the item. Stadium banners and
billboards are probably too far away and posters above arm level may be at too
acute an angle.

• In locations without adequate light. If you put a code on an outdoor poster and
you want people to use it at night, put it in a well-lit area.

FIELD TESTING
Field testing your Tags in the environment in which users are expected to discover
them is an essential component of a successful project or campaign. Developing
and field-testing a proof of concept may represent higher overhead initially, but
doing so can save you time and money in the long run.
Make sure to follow the production recommendations in this guide to ensure
that your Tag works on the broadest possible range of mobile devices. iPhone
and Android may have the most robust digital camera support, but not all of
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your mobile audience can be counted on to be using these devices. Make sure
to include a representative sample of low-end, middle-end, and high-end phone
models when field-testing your Tags. Microsoft is constantly updating the number
and variety of devices and platforms that are compatible with Microsoft Tag; see
the current list of supported devices and mobile platforms.

OPTIMIZING FOR MOBILE
Optimizing your web experience for a mobile device is imperative. Your
customers will have a more enjoyable and easier time consuming your content if
it’s designed to be viewed on a mobile device. Mobile device browsers often have
different characteristics than desktop browsers have, so it pays to assess how
the content delivered by each Tag displays on a wide variety of mobile device
browsers. Screen sizes and resolution, too, can vary considerably among different
phone models, and these factors can affect the readability of your content in
ways that are less predictable than on a desktop or laptop screen. Verify that any
important web features work as expected, regardless of the browser or device
used. Furthermore, test your content delivered by each Tag under a variety of
conditions for a range of different devices, browsers, and operating systems; for
example, by limiting the display to text-only content, preventing scripts from
running, and other variables.
Keep in mind, too, that video support varies greatly across different mobile
platforms and browsers. If your Tag’s target content includes a video, we strongly
recommend thorough testing to ensure that it downloads smoothly and the video
and audio play properly. (In fact, you may want to consider partnering with a
mobile video provider who can offer seamless support across different platforms
to deliver a great video experience.) Note: It’s important to remember that no
single video format will play on all supported platforms, so you will need to
determine how best to serve your expected audience.
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Information for the User

USER INSTRUCTIONS FOR DOWNLOADING AND
USING THE TAG APP
Because the idea of scanning barcodes with a mobile phone camera is fairly new
to most people, Microsoft recommends that you provide basic instructions near
each item that explains to users how to download and use the Microsoft Tag app.
(There are some exceptions – see "Where and when to display user instructions,"
below.)
A major benefit of using the Tag solution is that you can provide a single reader
for the two major types of 2D barcodes: Tag barcodes and QR Codes, as well as
the emerging NFC chip-based recognition technology. This makes using mobile
marketing much easier for your customers – and makes tracking your campaigns
much easier for you.
For maximum success, pay special attention to making it easy for users to figure
out how to use your materials. We encourage you to lean toward offering user
information wherever there’s a chance your user won’t know how to interact with
your materials.
Here are the specific guidelines for providing instructions next to Tag barcodes.
These concepts are also appropriate for QR Codes and NFC touchpoints.

• Location of user instructions in relation to the Tag. Location of user
instructions Instructions for downloading the Tag app should be printed below the
Tag barcode, QR Code, or NFC touchpoint.

• Required: Do not position any text or other markings within the white border
of the Tag barcode. The following are some examples of layout and suggested
language for Tag app download instructions:
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• Where and when to display user instructions. When you use a Tag
barcode, QR Code, or NFC touchpoint in a standalone situation, say on a single
ad in a magazine or on the back of a product package, always include instructions
for downloading and using the Tag app. In other instances you may not need to
repeat the instructions by each item. Just use the method that’s most likely to be
seen by the majority of people seeing your item. For example:

▪▪ If items are located throughout a retail, museum, or attraction
environment, you can provide the user instructions on signage located in
prominent locations in the store, museum, or attraction.

▪▪ If items are located throughout a catalog, magazine, or other printed
material, you can provide the information in prominent locations — say
on the table of contents page, masthead, or near major section heads,
instead of next to each item.

▪▪ Required: If your items are used as part of a video, the user instructions
must be presented at the beginning of the video content, instead of every
time that an item is displayed. The Tag app URL (http://gettag.mobi) must
be displayed as part of the video.

▪▪ If items will be delivered directly to another person, such as on a business
card, you may provide the information on the reverse side of the printed
material.

• Keep in mind: Because recognition technologies are still entering mainstream
use, it’s much better to lean toward providing ample and frequent user
instructions. Watch carefully during field testing to make sure everyone who uses
one of your items knows what to do. If they don’t, add the instructions.
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CUSTOMIZING USER INSTRUCTIONS FOR
DOWNLOADING THE TAG APP
When you use Tag Manager to create and download a Tag barcode, QR Code, or
NFC URL, you’re given the opportunity to include user instructions in the design,
as shown above. These standard instructions for downloading the Tag app (“Get
the free mobile app at http://gettag.mobi”) have been shown to be effective, but
you can also write your own instructions in the style and wording that suits your
audience and business objective. Keep your wording short and clear, and make
sure that your instructions accurately direct the user to the free Microsoft Tag app
download service: http://gettag.mobi. For usage and placement of customized
user instructions, please follow the User Instructions for Downloading the Tag
app.

Promotion of Services Related to Creating Tags
If you use the Microsoft Tag Web Services API to create Tag barcodes, QR Codes,
or NFC URLs on behalf of other third parties, you may not promote any of your
products or services in association with the API, Tag Manager web service, or
scannable items in a way that would make the ownership of the API, Tag Manager
web service, or Microsoft Tag recognition technologies confusing to the user.
Third parties should not associate their product name or reference their service
in close proximity to items created using the Microsoft Tag API service. The items
should be standalone and not adjacent to any branding but Microsoft Tag. Below
the user instructions for downloading the Tag app, however, third parties can
include plain text that promotes their services used to create Tag solutions, but
any related services should reference the “Microsoft Tag” or “Tag” product name.
See the “Correct” example, below, for an illustration of proper usage:

INCORRECT

CORRECT

Third Party
Brand/Service

Third Party
Brand/Service

Get the free mobile app at
http://gettag.mobi
This Tag was created using
<3rd Party Service Name>
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REL ATED CONTENT
The content that is published next to the Tag barcode, QR Code, or NFC
touchpoint should be reasonably related to the context in which the item is
published or printed. For example, the content associated with a Tag barcode
printed on a movie poster should reasonably relate to the movie or some aspect
of the movie.

General guidelines for related content:
• Set user expectations. Your content should explain to users in advance what
scanning the item will do. Will scanning your Tag barcode open a web session on
the phone? Will it dial a phone number? Will it download information onto the
phone, and if so, what information? A movie poster, for example, might say: “Scan
the Tag to view a behind-the-scenes look at the making of the movie,” or “Scan
the Tag to get $2.00 off your movie ticket.”

• Location of content in relation to the item. If content is printed with the
barcode or touchpoint, we recommend that the description of what the item
does should be printed above or to the left of the item. (User instructions for
downloading the Tag app should be printed below the Tag barcode, QR Code,
or NFC touchpoint.) (Required: When using a Tag barcode or QR Code, do not
position any text or other markings within the white border of the Tag.)

• Type font and type size. You can use any font to display related content.
(The default font is Arial.) You can use the type style that matches your brand
messaging, if you wish. There are no restrictions against boldface or italics, but
keep in mind that legibility is key.

Tag in print showing Tag content and user download instructions.
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Creating Tag's Recognition
Technologies

Creating a Tag barcode, QR Code, or NFC URL is fairly straightforward.
The first time you visit the Tag Manager web service, you will be
prompted to create a free user account. You can sign in with your
Windows Live username and password. (Sign up for a free Windows
Live account here or on the Tag Manager sign-in page.) Once you
have signed in, the Tag Manager page will be displayed. This is where
you select and create your recognition technology, prepare files for
production in other formats, and edit them as necessary.

GENERAL DESIGN GUIDELINES

Standard Tags:
Color and Black and White

QR Code

Tag barcodes and QR Codes are
generated in vector graphics
format so that they can be
infinitely scaled from small
to large yet maintain a crisp
visual appearance. Standard Tag
barcodes use a space-efficient
set of color or black-and-white

triangles. The symbol rows are separated from the frame and from one another
by row spacers. The black frame is enclosed in a white border, equal in width to
the height of the black bottom bar. See "About Tag Borders" for more details.
The number of symbol rows depends on the Tag barcode type. Standard color Tag
barcodes have five symbol rows, whereas standard black-and-white versions have
seven. Regardless of type, Tag barcodes always have twice as many symbols per
row as they have rows. So, standard five-row color Tag barcodes will always have
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10 symbols per row. Standard black-and-white
Tag barcodes will always have 14 symbols per
row.
For custom Tag barcodes, however, the symbols
can be color or black-and-white dots.
Custom Tags:
Color and Black and White

QR Codes have a standard set of lines and
circles to create their design. Their design
should not be modified to ensure scannability; use a custom Tag barcode if you
would like to change the color or add images or text to the background of your
barcode.
NFC touchpoints don’t require any kind of visual cue to function. However,
we recommend that you include the helper instructions to indicate to your
customers that your materials are interactive with their NFC-enabled phones. As
of this writing, the number of NFC-enabled devices in market is relatively few,
so we recommend pairing your NFC touchpoint with a Tag barcode or QR Code
to ensure that the maximum number of your audience can engage with your
content.

About Tag Barcodes and QR Code Borders
The border is an integral part of the Tag barcode and QR Code design that must
not be customized, obscured, or changed in any way. The border includes the
white area around the Tag barcode or QR Code (shown at left below; note that
the white border is the same width as the height of the bottom black bar) as well
as the black border and the timing markers – including the white bars at the top
and bottom and the small white squares on each side of the Tag barcode frame.
The second image (at right below) shows the specific areas (in gray) that cannot
be changed or removed. Any design changes in these areas may make the Tag
barcode unscannable by the Tag app.
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Remember: The width of the white space around any Tag barcode and QR Code is
equal to the height of the bottom black bar, as shown:

x

x

x

x

The following example shows the black horizontal bar or white border improperly
modified with text or an arrow:

INCORRECT

gettag

scan here
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Minimum Size for Standard Tag Barcodes and QR Codes
The following minimum sizes have proven to work well with a wide range of
camera phones. Note that these minimum size requirements include the white
space around the Tag barcode.

Standard Tags
• Standard color five-line Tag barcodes and black-and-white QR Codes must be
printed or displayed at a size of at least 3/4 inch x 3/4 inch.

• Standard black-and-white Tag barcodes must be printed or displayed at a size of
at least 7/8 inch x 7/8 inch.

7/8"
B/W Tag

3/4"
Color Tag

3/4"
QR Code
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Creating Custom Tag
Barcode Images

To provide a wide variety of branding and creative opportunities, Tag barcodes
are customizable. You can modify the design to suit your individual and business
goals. Note: Microsoft Tag supports customization of Tag barcodes saved in
.wmf and .pdf formats. Microsoft PowerPoint® supports .wmf files, but does not
support .pdf files. Tag barcodes saved as .pdf files as well as .wmf files can both
be customized using Adobe Illustrator.
The "Quick and Easy" approach lets you
customize Tag barcodes by using dots instead
of triangles and replacing the background
with an image. For example:

Using the "Advanced Design" approach,
you can create more intricate designs by
integrating symbols and other design
elements that disguise some or all of the dots.
For example:

Either type of customized image can be rendered in color or black and white.
Note: The minimum size of a customized Tag barcode is a 1.25-inch square,
including the mandatory white border.
Both design approaches start with creating a standard Tag barcode (URL, Free
Text, vCard, Dialer, or App Download). See Creating Standard Tags.
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Opacity
In designing color and black-and-white Tag barcodes with a custom background
image, opacity is an important consideration. Scannability can vary significantly,
depending on the device used, but the following minimum opacity levels for the
Tag barcode dots are recommended for successful scanning across a broad range
of device models and quality levels:

• Custom color Tags: opacity set to a minimum of 40 percent
• Custom black-and-white Tags: opacity set to a minimum of 50 percent

Minimum Size for Custom Tag Barcodes
The minimum size for customized Tag barcodes, whether rendered in color or
black and white, is 1.25 inch x 1.25 inch. This minimum size has proven to work
well with a wide range of camera phones.

1.25"
Color Tag

1.25"
B/W Tag

THE “QUICK AND EASY” APPROACH
Remember that Microsoft Tag only supports customization of Tag barcodes saved
in .wmf and .pdf formats. Microsoft PowerPoint supports .wmf files, but does not
support .pdf files. Tag barcodes saved as .pdf files as well as .wmf files can both
be customized using Adobe Illustrator, however.
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1. Open the Tag Manager.
2. Create a standard Tag.

OR

Select an existing Tag to customize from the Manage Existing Tags table.
3. In the Tag list, click the Download icon for the Tag that you want to customize. The Download dialog box will appear.
4. In the Download dialog box, Select Custom.
5. In the Render dialog box, use the File Type drop-down menu to do one
of the following:

• Select wmf to customize the Tag using Microsoft PowerPoint;
OR
• Select wmf or pdf to customize the Tag using Adobe Illustrator.
6. Specify the size of the Tag as equal to or larger than 1.25 inches.
7. Click Download.
8. Save the rendered Tag.

The resulting custom Tag barcode, like the one pictured
above, uses a matrix of color or black-and-white dots,
as opposed to the color or black-and-white triangles of
standard Tag barcodes. A custom Tag barcode can be used
as-is, or it can be further modified in a several ways, as
described in the following sections.
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Replace the Background Image
Once you’ve created and saved a custom Tag barcode, you’re ready to add your
own background. Here are steps for using Microsoft PowerPoint® or Adobe
Illustrator to customize the background of your Tag barcode.
Note: You may find this short video (3 minutes, 7 seconds) on customizing Tag
barcode images with Microsoft PowerPoint a helpful introduction.

To add a background image with PowerPoint:
1. Launch PowerPoint.
2. Create a new presentation.
3. Click the Insert tab in the ribbon.
4. In the Images group, click Picture.
5. Browse to and select the background image you want to use with your Tag
barcode, and then click Insert.
6. Click the Insert tab in the ribbon again.
7. In the Images group, click Picture.
8. Browse to and select the custom Tag barcode image file, and then click Insert.
9. Right-click the custom Tag barcode image.
10. On the shortcut menu, click Bring to Front.
11. Resize, crop, and position the background and custom Tag barcode image so
that the background fits inside the Tag barcode area. Make sure to maintain the
white space around the perimeter of the Tag barcode. For more information, see
"About Tag Barcode Borders".

12. Draw a box around the images to select both of them, as shown:

13. With both images selected, click the Format tab in the ribbon.
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14. In the Arrange group, click Group.
15. In the drop-down menu, click Group.
16. With the grouped image still selected, right-click the image.
17. On the shortcut menu, click Save as Picture.
18. Name the image and save it as a .jpg, .gif, .png, or .wmf file.

To add a background image with Adobe Illustrator:
1. Start Adobe Illustrator and open the Tag barcode image.
2. Rename Layer 1 to "Tag."
3. Create a new layer for the background image and name it "Background."

4. Drag the Background layer so that it is beneath the Tag layer, and then
lock the Tag layer.
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5. Click the Background layer bar to make Background the active layer.
6. On the File menu, click Place.
7. Select the image you want to use as the background image, and
then click Place.

Resize, crop, and position the background and custom Tag image as needed to make the background fit inside the Tag area. Make sure to maintain
the white space around the perimeter of the Tag. (For more information,
see "About Tag Barcode Borders". )

8. Save the Illustrator file.
9. Save the Tag as a file:

• On the File menu, click Export to save the Tag in .jpg, .gif, .png,
or other image format.

• On the File menu, click Save As to save the image in .pdf or other
file format.
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ADVANCED DESIGN GUIDELINES
Follow these design guidelines to create custom images that can
be read reliably:

• Preserve the Tag barcode borders. Remember that the image border is a part of
the Tag barcode that must not be customized, obscured, or changed in any way.

• Design for the color dots.
• Replace or integrate your Tag barcode's color dots with design elements of the
same color family, and in equivalent location.

• Maintain the hue of the original color dots. You have some flexibility to work
within a range of saturation and brightness within that hue (see Hue Ranges).

Replacing the Color Dots (the “Advanced Design” Method)
Once you have created a custom Tag barcode, you can use an image editor to
replace the color dots with other imagery or symbols, or you can incorporate
the color dots into surrounding design artwork. To create a reliable customized
image, you may disguise the existing color dots with an original design of your
choice, but the position of the existing dots must be maintained. The hue of the
custom design elements must match those of the dots they replace, though there
is some flexibility in the range of saturation and brightness within each hue (see
"Hue Ranges").

To incorporate the Tag dots into your design
1. Start your image editor application and open the custom image file
you've created for this purpose.
2. Create a new layer for the new symbols or design elements. Make sure
this layer is above the custom Tag barcode image layer.
3. Create new symbols or design elements for each color dot (or group of
dots), adhering to the location and hue requirements described below for
the color dots in your custom Tag image file.
4. Disguise the colored dots in the custom Tag image using your custom
design elements.
5. Save your customized Tag barcode.
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The figure below is an example of how you can replace the color dots with other
design elements while maintaining the hue and location of the original color
dots. The stars are carefully positioned to cover the original color dots and match
their hue

Notice, also, that within the Tag barcode frame you can use any design element
of any color in the areas not occupied by the color dots; apart from covering the
original dots and matching their color and location, the stars are otherwise purely
design elements with no additional functional relation to the original pattern of
color dots.
Depending on your design, you can replace the color dots one by one with other
design elements. You can also have a larger design element replace multiple color
dots. The first image shows two magenta dots and two black dots, which are then
individually covered by stars of the same color.

Original Tag Image (Detail):

CustomizedTag Image (Detail):

Make sure that the center of the original color dot is entirely enclosed within the
new design element, as shown in the detail image above.
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HUE RANGES
Hue, saturation, and brightness (HSB) values are used to describe the relationship
among colors. By using HSB values, you can ensure the color hues you use in
your custom images allow the Tag barcode to be scanned reliably. The Microsoft
Tag app can work within a range of brightness and saturation values for a color
dot hue to provide more creative flexibility in the design. Inside the Tag barcode
frame, you can use any design element of any color in the areas not occupied
by the color dots. In the figure below, the red squares indicate the acceptable
range of saturation and brightness for each of the non-black color hues. There is
also some flexibility regarding the black dots under certain conditions; see Color
Replacement.

The color areas shown below illustrate the dynamic range of saturation and
brightness for each of the three color hues.

Make sure that the brightness and saturation of your design elements are within
the acceptable range.
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COLOR REPL ACEMENT
Tag barcodes created using Tag Manager can show considerable resilience to
color changes without significant loss of scannability in many cases. Changing
the hue of the triangles in a standard Tag barcode or the dots in a custom image
– to more closely match a company logo or the color palette of a marketing
campaign, for example – may be possible. Of course, as with all Tag barcodes,
you should thoroughly field-test to verify that any modified versions will scan
reliably.
Our tests demonstrate the following results with regard to color substitution:

Change key black to another color. The results for replacing black with another color differed by Tag barcode type:
• Standard color: On most devices, the Tag app was able to scan a Tag barcode
when black is replaced with another color.

• Standard black-and-white: The Tag app on all platforms was able to scan a
Tag barcode when black was replaced with a different color.

• Custom color Tag barcode: The Tag app on most devices was able to scan a
custom color Tag barcode when black is replaced with another color.

• Custom black-and-white Tag barcode: The Tag app on most platforms
failed to scan a custom black-and-white Tag barcode when black is replaced with
another color.

Change white to another color. The results for replacing white with another
color differed by Tag type:
• Standard color: The Tag app on all platforms was able to scan a Tag barcode
when white was replaced with another color.

• Standard black-and-white: The Tag app on all platforms failed to scan a Tag
barcode when white was replaced with another color.

• Custom color Tag barcode: The Tag app on most platforms was able to scan a
Tag barcode when white was switched to another color.

• Custom black-and-white Tag barcode: The Tag app on most platforms
failed to scan a custom black-and-white Tag barcode when white was switched to
another color.
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Change yellow, magenta, or cyan to another color. Replacing one color with
another color on a Tag produced varied results:
• Yellow to magenta: When yellow is switched to magenta, when magenta is also
a color in the Tag barcode, the Tag app on all platforms will not scan regardless of
Tag type.

• Yellow to another color: The Tag app on all platforms was able to scan a Tag
barcode when yellow was replaced with a different color.

• Magenta to another color: The Tag app was able to scan a Tag barcode when
magenta was replaced with another color.

• Cyan to another color: The Tag app was able to scan a Tag barcode when cyan
was replaced with another color.

Note: QR Codes should remain black-and-white to ensure they will reliably scan.

COLOR INVERSION
When the colors of a Tag, regardless of Tag type, are inverted, the Tag app,
regardless of platform or device, will not properly scan the Tag.
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Displaying Tag Recognition
Technologies: In Print, Electronic Media,
and Other Surfaces
Regardless of the final medium on which the Tag recognition
technologies will be displayed, remember these primary considerations.
Pay particular attention to the interference in scan quality that can occur
when you put images on rough, reflective, or backlit surfaces, such as
cloth, glass, and computer screens. Needless to say, this goes extra for
more exotic surfaces such as food:
• Minimum size. Note that these minimum size requirements include the white
border around the Tag barcode or QR Code.

• Standard color five-line Tag barcodes must be printed or displayed at a
size of at least 3/4 inch x 3/4 inch.

• Standard black-and-white Tag barcodes or QR Codes must be printed or
displayed at a size of at least 7/8 inch x 7/8 inch.

• Custom Tag barcodes, whether rendered in color or black and white must
be printed or displayed at a size of at least 1.25 inch x 1.25 inch.

• Tag barcode or QR Code borders. Regardless of the display medium, the
white space surrounding the Tag barcode or QR Code image must be equal
in width to the height of the black bar at the bottom of the Tag. You must not
obscure or encroach in this space, or else the code may not be scannable.

• Dimensions and relative size. Ensure that the Tag appears in the correct
dimensions and size relative to the anticipated angle and distance from the user.

• Background. Ensure that the background material or color on which the Tag
barcode or QR Code appears does not interfere with the ability of the Tag app to
scan it.

• Lighting. Ensure that the environment in which the Tag barcode or QR Code is
published has sufficient and compatible lighting for users to scan it reliably.
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TAG BARCODES OR QR CODES IN ELECTRONIC
DISPL AYS
This section covers implementation considerations for Tag barcodes or QR Codes
that appear in light-emitting media such as televisions, computer monitors and
handheld device screens, LED reader boards, JumboTrons, and so on. Displaying
codes electronically can potentially reach a worldwide audience.
Electronic media typically emit the necessary light to illuminate displayed Tag
barcodes or QR Codes; however, glare or reflections from other light sources
in the environment can interfere with a camera phone's ability to scan an
electronically displayed code. Moreover, presenting 2D barcodes electronically
comes with a share of special considerations because of the wide variety and
quality of electronic display devices.
For the most part, the guidelines for printed Tag barcodes or QR Codes also
apply to codes in electronic displays. The main consideration for displaying
electronic barcodes has to do with variability in the size, type, and quality of
video monitors. Tag barcodes and QR Codes display well on LCD monitors,
but not so well on cathode ray tube (CRT) monitors. The problem stems not
from screen resolution or pixelation, but from variability in dots per inch (DPI)
among different monitor brands and models. If you want the 2D barcode to be
scannable on every possible video monitor, the Tag barcode or QR Code may end
up looking unattractively big on the average screen, while appearing too small to
be scanned on monitors with lower DPI.
Also keep in mind that effects from CRT screens are entirely dependent on the
imaging system of each camera phone type. The conversion of an image into a
digital signal can be entirely unpredictable from handset to handset, even when
from the same manufacturer, because of variations in the CCDs (charge-coupled
devices) in digital cameras.
Therefore, depending on the CRT screen and the mobile device used, the Tag
app may not be able to scan a given Tag barcode or QR Code on a CRT screen.
The image captured by the camera phone may be blurry due to the CRT
screen interlacing and other factors. As a general rule, assume that the average
computer user's screen displays 120 DPI, and then test your Tag barcode or
QR Code on a variety of computer monitors. The importance of thorough field
testing cannot be overemphasized when it comes to displaying 2D barcodes
electronically. Understand that there will be tradeoffs at each end of the CRT
screen spectrum.
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Beyond that, the main considerations with any Tag barcode or QR Code, electronic
or not, is to make sure that the barcode appears in the correct dimensions and size
relative to the user; that the barcode border is complete and not clipped; that any
image or color behind the custom Tag barcode does not interfere with readability;
and that there is sufficient brightness, clarity, and lack of glare or reflection in the
display for users to scan the code reliably.

TAG BARCODES AND QR CODES ON OBJECTS AND
IN OTHER MEDIA
This section covers implementation of Tag barcodes and QR Codes displayed
on surfaces other than general print media, such as on T-shirts, odd-shaped
product packaging, or any other surface that may not have the same lightreflecting qualities as regular print media. Examples might include a Tag barcode
stenciled onto a bike, car, or a bus, or printed on a plastic cling-on. 2D barcodes
can be printed using an edible confection on the surface of a candy wafer. They
can be created using heterogeneous or discrete materials, such as a design of
appropriately colored and placed jelly beans, buttons, marbles, or stones. They
can be woven or embroidered with fabric and thread. They can be placed on skin
as temporary tattoos (see below).
A custom Tag barcode may be "dressed up" so that it doesn't look like a Tag
barcode at all, but whatever its form, the Tag must be constructed and displayed
in such a way that it can be reliably scanned by the Tag app in the expected
environment. In addition to the guidelines described previously, pay close
attention to – and test for – required border, angle and surface curvature issues,
color accuracy, and environmental lighting.

TAG BARCODES OR QR CODES AS TEMPORARY
TAT TOOS
Temporary tattoos are a unique item for events, products, and entertainment. If
you choose to create temporary tattoos, there are some specific considerations
to keep in mind. To make a temporary tattoo out of a standard or custom Tag
barcode or QR Code, you will have to print the image in reverse using the same
process as for other temporary tattoo pictures. The image can be reversed during
the design stage in PowerPoint or Illustrator, or using reversed-image capabilities
at the printing stage. However, a reversed Tag barcode or QR Code cannot be
scanned, and some users may want to scan the 2D barcode without applying the
tattoo. It's a good idea to include a regular printed image of the barcode on the
back of the sheet of paper along with the user information and instructions.

30

There is also a diversity issue to consider if you create temporary tattoos. For
example, the background color of the user's skin may affect scannability. If the
skin is dark and the Tag barcode or QR Code has no white border, it will not
be scannable. You must include a white background and border (rather than a
transparent one) to avoid potential problems.
Moreover, tattoos of any kind, temporary or not, may be viewed negatively in
some cultures and by some social groups. A tattoo item may not be successful
among users who disapprove of the idea of applying an image to their skin. Make
sure to provide an alternative means of displaying the Tag barcode or QR Code
– such as with a card or an adhesive sticker – to help avoid cultural sensitivity
issues.

TAG BARCODE AND QR CODE SIZE REL ATIVE TO
THE VIEWER
As you increase the size of a Tag barcode or QR Code, the distance from which
it can be reliably scanned increases. This size-to-distance relationship follows a
linear progression as shown in the following graph:

Tag Size (inches)

Size vs. Distance
(inches)

Linear (Size vs.
Distance {inches})

Maxium Scan Distance (inches)

By using this graph, you can extrapolate the straight line to any Tag barcode
or QR Code size to determine the maximum distance from which it can be
successfully scanned. Based on these results, the safe maximum ratio of distance
to Tag barcode size is 7.5 to 1.
Note, however, that distant Tag barcodes and QR Codes must be illuminated
enough so that the device’s camera can detect it. Also note that the relative
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distance and angle of a large 2D barcode might not be uniform for all viewers
in large crowd situations (such as a Tag barcode displayed on a JumboTron in a
sports arena), so not all of the target audience will be able to scan it.

ENVIRONMENTAL CONSIDERATIONS FOR TAG
BARCODES AND QR CODES
• Reflections, shadows, and angles. Strong reflections or shadows on a Tag
barcode or QR Code will reduce how reliably it can be scanned. If possible, avoid
situations where bright reflections or sharp shadows fall across the image.

• Behind glass. Tag barcodes and QR Codes will normally be readable when
displayed behind glass, as in the window of a store or in a poster display case.
However, try to avoid situations where direct sunlight or bright lighting causes
strong glare on the glass.

• Vertical vs. horizontal display. Displaying Tag barcodes and QR Codes vertically
(for example, on a wall or in a window) reduces the possibility of the camera
phone itself casting a shadow across the image. Items placed horizontally (for
example, lying flat on a tradeshow table) may be more difficult to scan due to
issues with shadows. Bright overhead lighting can exacerbate this issue.

• Adequate lighting. Tag barcodes and QR Codes will be hard to read in dark
conditions, such as in a nightclub or candlelit restaurant. Moreover, the hue and
color saturation of mood lighting, such as strong blue or red lighting at an event,
can affect scanning detection. Neutral lighting is best for scanning 2D barcodes.

• Dots per inch. Tag barcodes and QR Codes display well on LCD monitors, but they
can run into some scannability problems on CRT monitors due to variability in
DPI values. Program your display for an average of 120 DPI, and make sure to test
your barcode on a variety of computer monitors.

• Avoid acute angles. The Tag app is generally very tolerant of skewed angles when
scanning Tag barcodes; however, the quality of some camera phones may make
it difficult to scan a Tag if the angle of the Tag relative to the user's phone is too
acute. The relative distance and angle of a big Tag on a JumboTron, for example,
may not be uniform in large crowd situations (for example, fans in a stadium). In
such cases, not all of the target audience will be able to scan the Tag. Note that QR
Codes generally do not scan well from acute angles, regardless of how minimally
the angle is skewed.

• Avoid acute curves. As a corollary to the preceding guideline, placing a Tag
barcode on a highly curved surface, such as a tube or a ball shape, may distort
the Tag too much and make it unreadable. That said, Tags can successfully be
displayed on cans, paper cups, and other curved surfaces, provided that all of the
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Tag is visible in the Tag app viewfinder at the same time in order to be scannable.
QR Codes typically do not scan well on curved surfaces, so a Tag barcode is
recommended to ensure scannability.

• 3D. Think ahead to imagine ways your flat design could end up in a curved
deployment. What if you make stickers and then apply them to candy canes? Or,
what if your ad is placed too close to the inside edge of a magazine page?

DESIGN AND USE CONSIDERATIONS FOR QR CODES
The guidelines for designing and presenting QR Codes are similar to those for
Tag barcodes. Your choice of design, materials, and display location will all have
an impact on scannability. In general, there is an increased element of risk that an
environmental factor will make it harder to scan the QR Code, so you need to pay
special attention to designing and testing your materials.
Regardless of the final medium on which the items will be displayed, remember
these primary considerations:

• Minimum size. Although a smaller size may work, ideally, a QR Code should be a
minimum of .75” by .75”square.

• Border. Just as with the Tag barcode, you need to keep the white border around
the QR Code clear of copy or design elements.

• QR Code borders. The code needs at least 1/8” border on all sides.
• Dimensions and relative size. Ensure that the QR Code appears in the correct
dimensions and size relative to the anticipated angle and distance from the user.

• Background. QR Codes have to appear on a light background.
• Lighting. Make sure there’s enough light in the environment where the code will
be displayed to ensure reliable scanning.
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DESIGN AND USE CONSIDERATIONS FOR NFC
TOUCHPOINTS
Because NFC touchpoints are physical chips attached to or embedded in your
content or materials, you’ll need to think differently about how to use them.
When you create an NFC URL with the Microsoft Tag solution, you’ll hand off that
URL to the NFC chip provider. They will be able to give you up-to-date advice on
the best way to use NFC.
Here are the key considerations to keep in mind as you begin planning an NFC
implementation:

• Audience: While increasingly prevalent on Android mobile phones, NFC is far
out on the bleeding edge of technology adoption. So at this point you’ll want to
reserve them for use in materials aimed at an Android-centric tech savvy audience.

• Accessibility: While a large Tag barcode or QR Code can be scanned from
a distance, an NFC touchpoint requires users to get within 5 cm to make a
connection.

• Cost effectiveness: NFC tags are expected to cost a couple of cents each,
making them much more expensive to use than printed barcodes. It’s more
cost-effective to use them in smaller numbers, say a limited direct mail campaign
or semi-permanent locations such as posters, exhibit labeling, and way-finding
applications, such as city guides.

• Durability: Typically, a user will be tapping the NFC touchpoint with their mobile
phone, so plan for your materials to be sturdy enough for regular handling. That
means heavier poster paper or even permanent attachment to exhibit signs and
other objects.

• Discoverability: Because the user doesn’t actually scan an image, it’s critical to
give a visual indication that the material contains a sensor, and where it is. Using
standard visual clues such as the image shown in the User Instructions above is
critical to a successful implementation.

• Unique advantages: While NFC presents a number of constraints, there are a
few excellent reasons to use them. Users can interact with an NFC-enabled object
in a more natural way, by simply tapping it or waving their phone nearby, rather
than physically scanning an image. In addition, NFC touchpoints aren’t affected by
production issues such as reflections, poor lighting or, within reason, placement on
irregularly shaped objects.
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We recommend that you add a marker to your image to denote for your
customers that it's NFC-enabled. Three radiating lines are commonly used in the
market today to indicate physical materials are enabled with an NFC touchpoint.
We also recommend that you pair a Tag barcode or QR Code with an NFC
touchpoint to ensure that a broad audience can engage with your content. Below
is an example of 2D barcodes with the three radiating lines to denote that the
materials are interactive either through scanning the barcode or tapping the NFC
touchpoint.

A FINAL WORD:
Following the suggestions in this guide should help ensure your recognition
technologies work well. We’ve said it a few times already in this guide, but it’s
worth repeating: always make a few proof-of-concept items and field-test them
under the same real-world conditions in which your target audience is expected
to encounter them. We want your campaign to be as successful as possible, so
please, take the time and effort to do this step.

Technical Support
If you encounter any issues or have additional questions about creating
or implementing Tags, please visit Microsoft Tag Resources or contact
TagSupp@microsoft.com.
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